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General Description
The MAX20360 evaluation kit (EV kit) is a fully assembled 
and tested circuit board that demonstrates the MAX20360 
ultra low-power wearable power management integrated 
circuit (PMIC). The MAX20360 includes voltage regula-
tors such as bucks, boost, buck-boost, and linear regula-
tors, and a complete battery management solution with 
battery seal, charger, power path, and fuel gauge.
The device is configurable through an I2C interface that 
allows for programming various functions and read-
ing device status. The EV kit GUI application sends 
commands to the Munich 2 USB-to-I2C adapter board 
(USB2PMB2#) to configure the device.

Features
 ● USB Power Option
 ● Flexible Configuration
 ● On-Board LED Current Sink and Battery Simulation
 ● Sense Test Point for Output-Voltage Measurement
 ● Filter Test Point for Haptic-Waveform Measurement
 ● Windows® 8/Windows 10-Compatible GUI Software
 ● Fully Assembled and Tested

EV Kit Contents
 ● MAX20360 EV kit
 ● USB2PMB2# board
 ● Two USB A to USB micro-B cables

319-100578; Rev 0; 8/20

Ordering Information appears at end of data sheet.

Quick Start
Required Equipment
Note: In the following sections, software-related items are 
identified by bold text. Text in bold refers to items directly 
from the install of EV kit software.

 ● MAX20360 EV kit
 ● Windows PC with USB ports
 ● One USB A to USB micro-B cable and Munich 2 

adapter board (USB2PMB2#)
 ● One USB A to USB micro-B cable or power supply 

(for battery simulation or battery voltage)
 ● Optional one USB A to USB micro-B cable or power 

supply (for charger input CHGIN)
 ● Voltmeter

Procedure
The EV kit is fully assembled and tested. To verify board 
operation, follow these steps:
1) Visit https://www.maximintegrated.com to down-

load the latest version of the EV kit software, MAX-
20360EVKitSetupVxxx.zip located on the MAX20360 
EV Kit web page. Download the EV kit software to a 
temporary folder and unzip the zip file.

2) Install the EV kit software on your computer by run-
ning the MAX20360EVKitSetupVxxx.exe program 
inside the temporary folder.

3) Verify that all jumpers are in their default positions, 
as shown in Table 1.

4) Connect the type-A end of a cable to the PC and 
micro-USB end of a cable to USB2PMB2# board, 
and connect the USB2PMB2# to J13 located on 
lower left of the EV kit board.

5) Connect a USB A to micro-B cable from the com-
puter to J21 on the upper right corner of the EV kit 
board to use VBUS to power the battery simulation 
circuits on the board, or power the battery simulation 
circuits from the VHC test point. (Use a Li-ion battery 
or power source to evaluate the device if not using 
the battery simulation circuits. Connect the battery or 
power source to J2 on the EV kit board. Skip step 6 
if not using the battery simulation.)

Windows is a registered trademark and service mark of 
Microsoft Corporation.

FILE DESCRIPTION
MAX20360EVKitSetupVxxx.exe PC GUI Program

EV Kit Files

Click here to ask about the production status of specific part numbers.

https://maximsupport.microsoftcrmportals.com/en-US/cust-support/
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6) Use a voltmeter to check VHC is approximately 5V; 
BATSIM test point is approximately 3.7V. To adjust 
the BATSIM voltage, turn the R58 BATSIM potenti-
ometer. Place shunt on JP9, then confirm that TP1 
CSN is the set BATSIM voltage.

7) On the computer, open the MAX20360 GUI. It should 
look like Figure 1, the status bar on the bottom dis-
plays MAX20360 Not Found.

Figure 1. MAX20360 Not Found Status
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8) Press the PB1 (/KIN) button until the device enters 
ON mode. The GUI then shows Connected and the 
registers are read and displayed (Figure 2).

9) The EV kit is now ready for additional evaluation.

10) To evaluate the battery charger, shunt J4 and plug 
in the USB micro-B cable to J1 of the EV kit to use 
USB VBUS power, or externally supply the charging 
power on TP9 CHGIN.

Figure 2. Connected Status
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Detailed Description of Software
Software Startup
Upon starting the program, the EV kit software automati-
cally searches for the USB interface circuit and then for 
the IC device addresses. The EV kit enters the normal 
operating mode when the connection is established and 
addresses are found. If the USB connection is not detect-
ed, the status bar displays Not Connected. If the USB 
connection is detected, but the MAX20360 is not found, 
the status bar shows MAX20360 Not Found.

ToolStrip Menu Bar
The ToolStrip menu bar (Figure 3) is located at the top 
of the GUI window. This bar comprises File, Device, 
Options, and Help menus; each function is detailed in 
the following sections.

File Menu
The File menu contains the option to exit out of the GUI 
program.

Device Menu
The Device menu provides the ability to connect or 
disconnect the EV kit to the GUI. The Advanced → 
I2C Read/Write menu allows to read from or write to a 
selected register with a specified slave address.

Options Menu
The Options menu provides several settings to access 
additional features offered by the GUI. The Disable 
Polling option allows registers to be read manually 
instead of receiving automatic frequent register updates 
from the IC. The Lock/Unlock option allows for the lock 
or unlock of the charger, bucks, boost, buck-boost, and 
LDOs through I2C. 

Help Menu
The Help menu contains the About option, which dis-
plays the GUI splash screen indicative of the GUI version 
being used.

Figure 3. The ToolStrip Menu Items



Maxim Integrated  │ 5www.maximintegrated.com

Evaluates: MAX20360MAX20360 Evaluation Kit

Tab Controls
The MAX20360 EV kit software GUI provides a conve-
nient way to test the features of the MAX20360. Each tab 
contains controls relevant to various blocks of the device. 
Changing these interactive controls triggers a write opera-
tion to the MAX20360 to update the register contents. The 
Read All button reads all the configuration registers that 
are visible on the current tab page. The Interrupts and 
Status section in each tab shows the state of the status 
registers and their corresponding interrupts. Checking 
or unchecking the Mask option controls which interrupts 
cause the INT output to be pulled low when asserted. 

Click the Read Interrupts button to read and clear the 
interrupts visible in the current tab. Asserted interrupts are 
denoted by bold text in the Interrupt Name. All statuses 
are polled continuously. The polling feature can be dis-
abled in the Options section of the menu bar by selecting 
Disable Polling.

General Tab
The General tab (Figure 4) provides information on 
device info, PFNs and MPCs status and configuration. 
Charger input current and voltage limit setting, IVMON 
setting, and some general interrupts and status are also 
found under this tab.

Figure 4. General Tab
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Charger Tab
The Charger tab (Figure 5) provides options to set charger voltage, current, and timer in different charging states. The 
thermistor monitor configuration can be accessed by clicking the Advanced button.

Figure 5. Charger Tab
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Buck1/2/3, Buck Boost Tab
The Buck1, Buck2, Buck3, and Buck Boost tabs (Figure 6, 7, 8, and 9) provide options to enable buck/buck boost, 
set buck/buck boost voltages, inductor current settings, DVS mode and voltage setting, and some additional settings.

Figure 6. Buck1 Tab
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Figure 7. Buck2 Tab
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Figure 8. Buck3 Tab
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Figure 9. Buck Boost Tab
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Boost and LEDs Tab
The Boost and LEDs tab (Figure 10) provide options to enable boost, set boost voltage, inductor current settings, enable 
LEDs, and LED current sink setting.

Figure 10. Boost and LEDs Tab
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Other DC-DC Tab
The Other DC-DC tab (Figure 11) includes SFOUT, Charge Pump, LDO1, and LDO2 settings.

Figure 11. Other DC-DC Tab
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Load Switches Tab
The Load Switches tab (Figure 12) includes Load Switch 1 and Load Switch 2 settings.

Figure 12. Load Switches Tab
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Haptic Driver Tab
The Haptic Driver tab (Figure 13) provides options to choose actuator type, haptic driver mode and different settings for 
each mode. To unmask the haptic interrupts, the HptStatIntM bit in 0x0D IntMask3 register also needs to be unmasked.

Figure 13. Haptic Driver Tab
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Register Map Tab
The Register Map tab (Figure 14) provides all names and values of MAX20360 registers. Click Read All on the top right 
corner to perform a burst read of all registers.
The left table shows the register to be read from or written to. The right table contains descriptions for each register field 
of the selected 8-bit register. All bits, along with their field names, are displayed at the bottom of the page.
To set a bit, click the bit label. Bold text represents logic 1 and regular text represents logic 0. To configure the changes 
to the device, click the Write button at the bottom right.

Figure 14. Register Map Tab
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Detailed Description of Hardware
The MAX20360 EV kit evaluates the MAX20360 ultra low-power wearable PMIC, which communicates over the I2C 
interface. The EV kit demonstrates the IC features such as bucks, buck-boost, boost, LED current sink, linear regula-
tors, battery charger, and haptic driver. The EV kit uses the IC in a 72-bump wafer-level package on a proven, six-layer 
PCB design. The EV kit can use USB VBUS 5V DC for battery and charger input power source. Alternatively, the EV kit 
can be powered from an external power supply. Figure 15 and Figure 16 show the EV kit and block annotated pictures.

Figure 15. MAX20360 EV Kit Board Picture
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Figure 16. MAX20360 EV Kit Block Annotated Picture
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Hardware Setup
To use the EV kit with the GUI, connect the USB2PMB2# 
to the PMOD connector in the bottom left corner of the 
board. The USB2PMB2# also provides 3.3V to the logic 
voltage VIO of the EV kit when shunting J20. Use the J21 
USB VBUS to power the battery simulation circuits on the 
EV kit to supply BAT of the IC. Turning the R58 potentiom-
eter can change the BATSIM voltage. Connect BATSIM to 
BAT of the IC with shunt on JP9. Alternatively, instead of 
using battery simulation circuits on the board, connect a 
Li-ion battery on J2 connector. Use the J1 USB VBUS as 
CHGIN source and place shunt on J4.

PFNs and MPCs States
The PFNs and MPCs can be pulled up to VIO through a 
100kΩ resistor, or connected to ground through 100kΩ 
resistor. 

Regulators and Peripherals
All regulator outputs are made available on test points. 
The inputs to the LDO1, LDO2, Load Switch 1, and Load 
Switch 2 must be supplied externally through test points. 
The LDO2 input can be supplied from VCCINT of IC if 
set through the I2C. Bucks, buck-boost, and boost output 
have sense test points which provide easy voltage mea-
suring. 

Thermistor and SET Adjustment
When the J6 shunt is installed, THM is pulled up to TPU 
through a 10kΩ resistor. Header J19 is used to select the 
pull-down resistor for THM. When pin 1 and 2 is shunted, 
potentiometer R14 is used to simulate a thermistor at 
THM. When pin 2 and 3 is shunted, a fixed 10kΩ resistor 
is connected between THM and ground.

Header J18 is used to select the resistor for RISET which 
sets the fast-charge current IFCHG. Shunting pin 1 and 
2 selects potentiometer R63. Change RISET to change 
IFCHG. Shunting selects a fixed 10kΩ resistor, which sets 
fast-charge current to 0.2A.

INT and RST LED Indicators
Shunts can be installed on J7 and J8 to show the status 
of INT and RST as LED indicators, DS2 and DS3.  When 
the corresponding LED illuminates, it verifies the active-
low output is pulled low.

Haptic Driver
Select haptic driver supply using J23. When pin 1 and 2 is 
shunted, HDIN is powered from SYS. When pin 2 and 3 is 
shunted, HDIN is sourced from BBOUT. The haptic driver 
output is available on J5 where an LRA or ERM vibration 
motor can be connected. By shunting J24 and J25, haptic 
waveform can be measured with the on board low-pass 
filters which convert pulse-width-modulation (PWM) to 
sinewave.

LED Current Sink
The EV kit includes multiple LEDs to test the LED0, LED1, 
and LED2 current sinks. The current source for LED1 and 
LED2 can be connected to SYS by shunting J14. The cur-
rent source for LED0 can be selected between SYS and 
BSTOUT by J17. Using J16, select between sinking the 
current from one LED or three LEDs for LED0.

Jumper Setting
Table 1 shows the detailed jumper setting, and Table 2 
shows the connector description.

Table 1. Jumper Setting
JUMPER SHUNT POSITION DESCRIPTION

J3 1-2* CSN connect to FGBAT
J4 1-2 CHGIN connect to USB VBUS from J1
J6 1-2* THM connect to TPU for thermistor monitoring
J7 1-2* INT connect to pull up VIO and DS2.
J8 1-2* RST connect to pull up VIO and DS3.

J9
1-2 MPC0 pull down to ground
1-3 MPC0 connect to GPIO3
1-4 MPC0 pull up to VIO

J10
1-2 PFN1 pull down to ground
1-3 PFN1 connect to GPIO1
1-4 PFN1 pull up to VIO
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Table 1. Jumper Setting (continued)

*Default position.

JUMPER SHUNT POSITION DESCRIPTION

J11
1-2 MPC1 pull down to ground
1-3 MPC1 connect to GPIO4
1-4 MPC1 pull up to VIO

J12
1-2 PFN2 pull down to ground
1-3 PFN2 connect to GPIO2
1-4 PFN2 pull up to VIO

J14 1-2 LED1/LED2 supply from SYS voltage

J16
1-2 LED0 connect to one LED
2-3 LED0 connect to three LEDs

J17
1-2 LED0 supply from SYS
2-3 LED0 supply from BSTOUT

J18
1-2 ISET connect to potentiometer
2-3* ISET connect to 10kΩ (fast-charge current 0.2A)

J19
1-2 THM connect to potentiometer
2-3* THM connect to 10kΩ (50%/room zone)

J20 1-2* VIO connect to 3.3V from PMOD
J22 1-2* VHC connect to USB VBUS from J21

J23
1-2* HDIN connect to SYS
2-3 HDIN connect to BBOUT

J24 1-2 DRP connect to low-pass filter which convert PWM to sinewave, measure filtered waveform at 
DRP_F 

J25 1-2 DRN connect to low-pass filter which convert PWM to sinewave, measure filtered waveform at 
DRN_F

J27
1-2 MPC4 pull up to VIO
2-3 MPC4 pull down to ground

J28
1-2 MPC3 pull up to VIO
2-3 MPC3 pull down to ground

J30
1-2 MPC7 pull up to VIO
2-3 MPC7 pull down to ground

J31
1-2 MPC6 pull up to VIO
2-3 MPC6 pull down to ground

J33
1-2 MPC2 pull up to VIO
2-3 MPC2 pull down to ground

J34
1-2 MPC5 pull up to VIO
2-3 MPC5 pull down to ground

J39
1-2 SDA connect to ground
2-3 SCL connect to ground

JP9 1-2 BATSIM connect to CSN
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#Denotes RoHS compliant.

Table 2. Connectors Description
CONNECTOR DESCRIPTION

J1 Connect to USB cable for CHGIN voltage
J2 Connect to battery
J5 Connect to LRA/ERM haptic actuator

J13 Connect to USB2PMB2#
J15 Connect to MAX20361 EV kit

PART TYPE
MAX20360EVKIT# EVKIT

Ordering Information
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MAX20360 EV Kit Bill of Materials
ITEM REF_DES DNI/DNP QTY MFG PART # MANUFACTURER VALUE DESCRIPTION COMMENTS

1 BATSIM, TP1-TP6, TP10-TP13, 
TP18-TP21

- 15 5003 KEYSTONE N/A

TEST POINT; PIN DIA=0.1IN; TOTAL 
LENGTH=0.3IN; BOARD HOLE=0.04IN; 
ORANGE; PHOSPHOR BRONZE WIRE 
SILVER PLATE FINISH; 

 

2
BBOUT_S, BK1OUT_S-BK3OUT_S, 
BSTOUT_S, DRN_F, DRP_F, TP14-
TP17, TP36, TP37

- 13 5002 KEYSTONE N/A

TEST POINT; PIN DIA=0.1IN; TOTAL 
LENGTH=0.3IN; BOARD HOLE=0.04IN; 
WHITE; PHOSPHOR BRONZE WIRE 
SILVER; 

 

3 C1 - 1

CGA2B3X7R1H104K050BB;
C1005X7R1H104K050BB;
GRM155R71H104KE14;
GCM155R71H104KE02;
C1005X7R1H104K050BE;
UMK105B7104KV-FR;
CGA2B3X7R1H104K050BE

TDK;TDK;MURATA;MURATA;
TDK;TAIYO YUDEN;TDK

0.1UF
CAPACITOR; SMT (0402); CERAMIC 
CHIP; 0.1UF; 50V; TOL=10%; TG=-55 
DEGC TO +125 DEGC; TC=X7R

 

4 C2 - 1 C1005X5R1V225K050BC TDK 2.2UF CAP; SMT (0402); 2.2UF; 10%; 35V; 
X5R; CERAMIC CHIP

 

5 C3, C5, C13-C17, C21, C22 - 9 C1005X5R0J475K050BC TDK 4.7UF
CAPACITOR; SMT (0402); CERAMIC 
CHIP; 4.7UF; 6.3V; TOL=10%; TG=-55 
DEGC TO +85 DEGC; TC=X5R

 

6 C4 - 1 C1005X5R0J225K050BC;
CL05A225KQ5NSN

TDK;SAMSUNG 2.2UF

CAPACITOR; SMT (0402); CERAMIC; 
2.2UF; 6.3V; TOL=[10%]; MODEL=C 
SERIES; TG=-55 DEGC TO +85 DEGC; 
TC=X5R

 

7 C6-C9, C11, C18, C20, C40 - 8 GRM155R60J226ME11 MURATA 22UF CAPACITOR; SMT (0402); CERAMIC 
CHIP; 22UF; 6.3V; TOL=20%; TC=X5R ;

 

8 C10, C19 - 2 GRM188R6YA106MA73 MURATA 10UF
CAPACITOR; SMT (0603); CERAMIC 
CHIP; 10UF; 35V; TOL=20%; TG=-55 
DEGC TO +85 DEGC; TC=X5R

 

9 C12 - 1
GRM155R71A273KA01;
0402ZC273KAT2A;
CC0402KRX7R6BB273

MURATA;AVX;YAGEO 0.027UF
CAPACITOR; SMT (0402); CERAMIC 
CHIP; 0.027UF; 10V; TOL=10%; TG=-55 
DEGC TO +125 DEGC; TC=X7R

 

10 C23, C27 - 2
GRM31CR71H475KA12;
GRJ31CR71H475KE11;
GXM31CR71H475KA10

MURATA;MURATA;MURATA 4.7UF
CAPACITOR; SMT (1206); CERAMIC 
CHIP; 4.7UF; 50V; TOL=10%; MODEL=; 
TG=-55 DEGC TO +125 DEGC; TC=X7R

 

11 C24 - 1 C1608X5R1H104K080AA TDK 0.1UF

CAPACITOR; SMT (0603); CERAMIC 
CHIP; 0.1UF; 50V; TOL=10%; MODEL=C 
SERIES; TG=-55 DEGC TO +85 DEGC; 
TC=X5R

 

12 C25, C33, C35-C38 - 6

C1005X7R1C104K050BC;
ATC530L104KT16;
0402YC104KAT2A;
CGA2B1X7R1C104K050BC;
GCM155R71C104KA55;
C0402X7R160-104KNE;
CL05B104KO5NNNC;
GRM155R71C104KA88;
C1005X7R1C104K;
CC0402KRX7R7BB104;
EMK105B7104KV;
CL05B104KO5

TDK;AMERICAN TECHNICAL 
CERAMICS;AVK;TDK;MURATA;VEN
KEL LTD.;SAMSUNG 
ELECTRONICS;MURATA;TDK;YAGE
O PHICOMP;TAIYO 
YUDEN;SAMSUNG ELECTRONICS

0.1UF
CAPACITOR; SMT (0402); CERAMIC 
CHIP; 0.1UF; 16V; TOL=10%; TG=-55 
DEGC TO +125 DEGC; TC=X7R

 

13 C26 - 1
C0603C225K9PAC; 
GRM188R60J225KE01; 
C1608X5R0J225K080AB

KEMET;MURATA;TDK 2.2UF
CAPACITOR; SMT (0603); CERAMIC 
CHIP; 2.2UF; 6.3V; TOL=10%; MODEL=; 
TG=-55 DEGC TO +85 DEGC; TC=X5R; 

 

14 C28 - 1 C0603C475K9PAC KEMET 4.7UF
CAPACITOR; SMT (0603); CERAMIC 
CHIP; 4.7UF; 6.3V; TOL=10%; MODEL=; 
TG=-55 DEGC TO +85 DEGC; TC=X5R; 

 

15 C29 - 1 C0402X7R500-222KNE; 
GRM155R71H222KA01

VENKEL LTD.;MURATA 2200PF
CAPACITOR; SMT (0402); CERAMIC 
CHIP; 2200PF; 50V; TOL=10%; TG=-55 
DEGC TO +125 DEGC; TC=X7R

 

16 C30 - 1 C0603C104K8RAC KEMET 0.1UF

CAPACITOR; SMT (0603); CERAMIC 
CHIP; 0.1UF; 10V; TOL=10%; 
MODEL=C0603 SERIES; TG=-55 DEGC 
TO +125 DEGC; TC=X7R

 

17 C31 - 1 C3216X5R1C476M160AB;
GRM31CR61C476ME44

TDK;MURATA 47UF
CAPACITOR; SMT (1206); CERAMIC 
CHIP; 47UF; 16V; TOL=20%; TG=-55 
DEGC TO +85 DEGC; TC=X5R

 

18 C32 - 1 C3216X5R1H106K160AB;
GRM31CR61H106KA12

TDK;MURATA 10UF
CAPACITOR; SMT (1206); CERAMIC 
CHIP; 10UF; 50V; TOL=10%; TG=-55 
DEGC TO +85 DEGC; TC=X5R

 

19 C34 - 1 GRM188R60J105KA01 MURATA 1UF

CAPACITOR; SMT (0603); CERAMIC 
CHIP; 1UF; 6.3V; TOL=10%; 
MODEL=GRM SERIES; TG=-55 DEGC TO 
+85 DEGC; TC=X5R; 

 

20 DS1-DS3, DS10 - 4 LG L29K-G2J1-24 OSRAM LG L29K-G2J1-24 DIODE; LED; SMT (0603); Vf=1.7V; 
If(test)=0.002A; -40 DEGC TO +100 DEGC

 

21 DS4, DS8, DS9 - 3 LTST-C171TBKT LITE-ON ELECTRONICS INC. LTST-C171TBKT DIODE; LED; SMD LED; BLUE; 
SMT (0805); PIV=5V; IF=0.020A

 

22 DS5-DS7 - 3 LTST-C150KRKT LITE-ON ELECTRONICS INC. LTST-C150KRKT
DIODE; LED; STANDARD; RED; 
SMT (1206); PIV=2V; IF=0.02A; -30 DEGC 
TO +85 DEGC

 

23 J1, J21 - 2 ZX62D-B-5P8 HIROSE ELECTRIC CO LTD. ZX62D-B-5P8
CONNECTOR; MALE; SMT; MICRO 
UNIVERSAL SERIES BUS B-TYPE 
CONNECTOR; RIGHT ANGLE; 5PINS

 

24 J2, J5 - 2 800-10-002-10-001000 MILLMAX 800-10-002-10-001000 CONNECTOR; MALE; TH; SINGLE 
ROW; STRAIGHT; 2PINS

 

25 J3, J4, J6-J8, J14, J20, J22, 
J24, J25, JP9

- 11 PBC02SAAN SULLINS ELECTRONICS CORP. PBC02SAAN CONNECTOR; MALE; THROUGH 
HOLE; BREAKAWAY; STRAIGHT; 2PINS
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MAX20360 EV Kit Bill of Materials (continued)
ITEM REF_DES DNI/DNP QTY MFG PART # MANUFACTURER VALUE DESCRIPTION COMMENTS

26 J9-J12 - 4 TSW-104-07-L-S SAMTEC TSW-104-07-L-S
EVKIT PART-CONNECTOR; MALE; 
THROUGH HOLE; TSW SERIES; SINGLE 
ROW; STRAIGHT; 4PINS

 

27 J13 - 1 PBC06DBAN SULLINS ELECTRONICS CORP. PBC06DBAN
CONNECTOR; MALE; THROUGH 
HOLE; BREAKAWAY; STRAIGHT; 12PINS -  
ALTERNATE PIN NUMBERING

 

28 J15 - 1 PEC04SBAN SULLINS ELECTRONICS CORP. PEC04SBAN

CONNECTOR; MALE; THROUGH 
HOLE; 0.100INCH CONTACT CENTERS; 
MALE BREAKAWAY HEADERS; RIGHT 
ANGLE; NO MOUNTING; 4PINS

 

29 J16-J19, J23, J27, J28, J30, 
J31, J33, J34, J39

- 12 PBC03SAAN SULLINS PBC03SAAN
CONNECTOR; MALE; THROUGH 
HOLE; BREAKAWAY; STRAIGHT; 3PINS; -
65 DEGC TO +125 DEGC

 

30 L1-L3, L5 - 4 DFE201612E-2R2M MURATA 2.2UH
INDUCTOR; SMT (0806); 
WIREWOUND CHIP; 2.2UH; TOL=+/-20%; 
1.8A

 

31 L4 - 1 DFE201612E-4R7M MURATA 4.7UH INDUCTOR; SMT (0806); METAL; 
4.7UH; 20%; 1.20A

 

32 PB1 - 1 1825910-6 TE CONNECTIVITY 1825910-6

SWITCH; SPST; THROUGH HOLE; 
24V; 0.05A; TACTILE SWITCH; RCOIL=0 
OHM; RINSULATION=100M OHM; TE 
CONNECTIVITY

 

33 R1, R13, R15, R16 - 4 ERJ-2RKF1001 PANASONIC 1K RESISTOR; 0402; 1K OHM; 1%; 
100PPM; 0.10W; THICK FILM

 

34 R2, R10, R11, R38-R40, 
R49, R53

- 8 CRCW040210K0FK;
RC0402FR-0710KL

VISHAY DALE;YAGEO PHICOMP 10K RESISTOR; 0402; 10K; 1%; 100PPM; 
0.0625W; THICK FILM

 

35 R3, R4, R44, R47, R55, R60 - 6 ERJ-2RKF3000 PANASONIC 300 RESISTOR; 0402; 300 OHM; 1%; 
100PPM; 0.1W; THICK FILM

 

36 R5 - 1 ERJ-2LWFR010 PANASONIC 0.01 RES; SMT (0402); 0.01; 1%; 0 TO 
+500PPM/DEGC; 0.2W

 

37 R6 - 1 ERJ-2GEJ103 PANASONIC 10K RESISTOR; 0402; 10K OHM; 5%; 
200PPM; 0.10W; THICK FILM

 

38 R7, R17-R21, R23-R35, R41, 
R45, R46, R48, R50, R57

- 25 ERJ-2GEJ104 PANASONIC 100K RESISTOR; 0402; 100K OHM; 5%; 
200PPM; 0.10W; THICK FILM

 

39 R8, R9, R12, R42 - 4 CRCW0402499RFK VISHAY DALE 499 RESISTOR; 0402; 499 OHM; 1%; 
100PPM; 0.0625W; THICK FILM

 

40 R14, R63 - 2 PV36Y105C01B00 MURATA 1M

RESISTOR; THROUGH-HOLE-
RADIAL LEAD; PV36 SERIES; 1M OHM; 
10%; 100PPM; 0.5W; TRIMMER 
POTENTIOMETER; 25 TURNS; MOLDER 
CERAMIC OVER METAL FILM

 

41 R22, R36, R37 - 3 CRCW040210R0JNEDHP VISHAY DRALORIC 10 RESISTOR; 0402; 10 OHM; 5%; 
200PPM; 0.2W; THICK FILM

 

42 R43 - 1 CRCW04024K70FK;
MCR01MZPF4701

VISHAY DALE;ROHM 
SEMICONDUCTOR

4.7K RESISTOR, 0402, 4.7K OHM, 1%, 
100PPM, 0.0625W, THICK FILM

 

43 R51 - 1 ERJ-2GE0R00 PANASONIC 0 RESISTOR; 0402; 0 OHM; 0%; 
JUMPER; 0.10W; THICK FILM

 

44 R52 - 1 ERJ-2RKF5100 PANASONIC 510 RESISTOR; 0402; 510 OHM; 1%; 
100PPM; 0.10W; THICK FILM

 

45 R54, R56 - 2 WSL0805R1000FEA18 VISHAY DALE 0.1 RESISTOR; 0805; 0.1 OHM; 1%; 
75PPM; 0.125W; THICK FILM

 

46 R58 - 1 3296Y-1-253LF BOURNS 25K

RESISTOR; THROUGH-HOLE-
RADIAL LEAD; 3296 SERIES; 25K OHM; 
10%; 100PPM; 0.5W; SQUARE TRIMMING 
POTENTIOMETER; 25 TURNS; MOLDER 
CERAMIC OVER METAL FILM

 

47 R59 - 1 ERJ-2RKF1152 PANASONIC 11.5K RESISTOR; 0402; 11.5K OHM; 1%; 
100PPM; 0.10W; THICK FILM

 

48 R61 - 1 CRCW04023K40FK VISHAY DALE 3.4K RESISTOR; 0402; 3.4K OHM; 1%; 
100PPM; 0.063W; THICK FILM

 

49 SPACER1-SPACER4 - 4 9032 KEYSTONE 9032
MACHINE FABRICATED; ROUND-
THRU HOLE SPACER; NO THREAD; 
M3.5; 5/8IN; NYLON

 

50
SU3, SU4, SU6-SU12, SU14, 
SU16-SU20, SU23-SU25, SU27, SU28, 
SU30, SU31, SU33, SU34

- 24 S1100-B;SX1100-B;
STC02SYAN

KYCON;KYCON;SULLINS 
ELECTRONICS CORP.

SX1100-B

TEST POINT; JUMPER; STR; TOTAL 
LENGTH=0.24IN; BLACK; 
INSULATION=PBT;PHOSPHOR BRONZE 
CONTACT=GOLD PLATED

 

51 TP7-TP9, VHC - 4 5000 KEYSTONE N/A

TEST POINT; PIN DIA=0.1IN; TOTAL 
LENGTH=0.3IN; BOARD HOLE=0.04IN; 
RED; PHOSPHOR BRONZE WIRE 
SILVER PLATE FINISH; 

 

52 TP22-TP33 - 12 5001 KEYSTONE N/A

TEST POINT; PIN DIA=0.1IN; TOTAL 
LENGTH=0.3IN; BOARD HOLE=0.04IN; 
BLACK; PHOSPHOR BRONZE WIRE 
SILVER PLATE FINISH; 

 

53 U1 - 1 MAX20360EEWZ+ MAXIM MAX20360EEWZ+

EVKIT PART - IC; WEARABLE 
POWER NAMAGEMENT SOLUTION; 
PACKAGE OUTLINE DRAWING: 21-
100373; WLP 72 PINS; 0.5MM PITCH; 
PACKAGE CODE: W724A4+1

 

54 U2 - 1 OPA569AIDWPR TEXAS INSTRUMENTS OPA569AIDWPR IC; AMP; RAIL-TO-RAIL I/O; POWER 
AMPLIFIER; WSOIC20-EP 300MIL

 

55 U3 - 1 MAX8880EUT+ MAXIM MAX8880EUT+
IC; VREG; ULTRA-LOW-IQ LOW-
DROPOUT LINEAR REGULATOR WITH 
POK; SOT23-6

 

56 U4 - 1 NC7WZ07P6X FAIRCHILD SEMICONDUCTOR NC7WZ07P6X IC; BUF; TINY LOGIC ULTRA-HIGH 
SPEED DUAL BUFFER; SC70-6

 

57 PCB - 1 MAX20360 MAXIM PCB PCB:MAX20360 -

TOTAL 227
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MAX20360 EV Kit Schematics
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MAX20360 EV Kit Schematics (continued)
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MAX20360 EV Kit Schematics (continued)
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MAX20360 EV Kit PCB Layout—Silk Top MAX20360 EV Kit PCB Layout—Layer2

MAX20360 EV Kit PCB Layout—Top MAX20360 EV Kit PCB Layout—Layer3

MAX20360 EV Kit PCB Layouts
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MAX20360 EV Kit PCB Layout—Layer4 MAX20360 EV Kit PCB Layout—Bottom

MAX20360 EV Kit PCB Layout—Layer5 MAX20360 EV Kit PCB Layout—Silk Bottom

MAX20360 EV Kit PCB Layouts (continued)
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